
      

Overview of features
      

Femta is the only application that gives you all these great features:

· Very easy to use interface
· The eternal calendar with possibility to display from 1 to 36 months simultaneously 
· 5 types of charts, calculated using the data of Your past periods
· Easy browsing of the calendar and charts
· Synchronization of moving on the calendar and charts
· Conveniently viewing of the periods and calculated probabilities in the calendar
· Easy to note or change dates of period in the calendar
· Fast access to the all important functions from the pop up menus, tool bar or main menu.
· Automatic checking of possibility to record a period at chosen date to prevent mistakes
· Very configurable :

·        Easy to change any colors of the calendar or charts
·      Easy to change the fonts of the calendar or charts
·      A lot of settings for viewing of the calculated probabilities
·      Different forms for changing of preferences of the calendar, charts, and general settings
·      Preference forms contain the calendar and charts with the real user data
·      Immediately view changes in the calendar and charts
·        Several predefined color sets
·        User can create and save custom color sets
·        Easily hide or show charts or other program objects

· Automatic saving of the configuration
· The easy-to-use Wizard with explanation of all user actions
· WYSIWYG Print preview with a lot of possibilities
· Undo    the last actions
· Possibility of using password for Femta starting
· Compatibility of the Femta database and easy upgrade to the new versions of Femta
· Context sensitive help from anywhere in the program
· Good installation / uninstallation program
· Year 2000 Compliance

See also
What is Femta ?
Why to use Femta ?
Who can use Femta ?



      

What is Femta ?
      

Femta is an application for women. It contains a lot of useful possibilities, which help you:

· Plan your sexual life and use the natural method of contraception. Femta calculates the probabilities of becoming pregnant for 
every day and displays them in the charts and calendar. You can easy view and determine the “safe” and “unsafe” periods. 

· Keep the track of your cycles. With Femta you can easy record all your periods: menstruations, pregnancy and childbirth, 
lactation.

· Plan your family and control the conception of your child. You can use Femta to avoid or for achieving pregnancy.
· Determine the estimated date of childbirth.
· Plan the gender of your future child. Using Femta you can increase the probability to conceive the child with the desired sex.
· Predict future cycles, making it possible for you to plan menstruation-free important events, such as vacation, trip or travel, 

romantic getaway, sport competitions,wedding, honeymoon and others important events.    It will estimate the dates of your 
future periods several months ahead.

Femta allows you to view conveniently all the data in the calendar and 5 types of charts, contains a lot of settings for displaying of 
data, includes other great features, such as Wizard, Print Preview, context sensitive help etc.

There are only several days in which You can become pregnant in each cycle. With Femta You can easy determine these days and 
plan Your intimate life. You can use the natural method of contraception based on calculation of these days. Femta - is the best 
program for such purposes, it will do all calculations for You.

The emotional, psychological state and sexual feelings of woman often depend on the day of current cycle. With Femta You can 
watch it easy.

Femta will relieve you from the burden of counting the days on a calendar and avoid errors in calculations.
All the periods and any calculated probabilities can conveniently view on the calendar.

Femta is very easy-to-use, configurable, well-designed, high-quality application with affordable price.

Femta is very useful and necessary application for every woman.

See also
Overview of features
Why to use Femta ?
Who can use Femta ?



 

Installation and Uninstallation
    

Installation
The installation is quite simple: You only need to run the Femta.exe and follow the directions given in the screen. The automatic 
installation procedure will copy all the necessary files to the specified directory and create the shortcut for the program. You may 
want to manually create a second shortcut for Femta in your StartUp folder if you want automatic starting of Femta.

Uninstallation
The program can be easily uninstalled.    You can uninstall Femta from the Control Panel Add/Remove Applications window.    
Activate the Control Panel, double click Add/Remove Programs, and double click on the Femta list box entry.

Note: Before uninstalling don`t forget to save the Femta database, which contains Your data and all saved settings for using it later, 
or with the new version of Femta.

See also
System Requirements
How to upgrade to the new version of Femta



      

Why to use Femta ?
        

Because...
· You want to keep a precise track of your periods
· You want to know Your "safe" and "unsafe" days
· You want to use the natural method of contraception
· You want to plan Your intimate life
· You want to plan    menstruation-free trips or travels, vacations, romantic getaway, wedding, honeymoon and other important 

events. 
· You have to participate in a sport competition
· You don't want to count days on a calendar
· You don't want to    lose your menstrual calendar
· You are trying to become pregnant
· You want to conceive a child with a defined gender
· You want to know the current period of pregnancy
· You want to know the estimated date of the childbirth

Every woman can find something useful in Femta.

See also
What is Femta ?
Overview of features
Who can use Femta ?



 

Who can use Femta ?
      

· Every woman can use Femta
· Every family can use it
· Every male can use Femta - if he would like to help his wife or girlfriend to take care of contraception or planning events 
· Every gynecologist can refer to Femta

See also
What is Femta ?
Overview of features
Why to use Femta ?



      

What is registration ?
      

Femta is not free software, nor public domain software.    Authors made it by their investment and spent a lot of their own time. The 
unregistered version of Femta available to You for free evaluation.    You are entitled to evaluate the software for up to 50 days 
without obligation to pay.    Within 50 days, if You decide to keep the software, You must register your copy with us for a small fee.

Evaluation (non-registered) Femta is a "full-featured" release.    It means that the same features (capabilities) of Femta available in 
the registered software are present in the non-registered software.    It allows You to try out all the features in Femta to confirm that 
they work to your satisfaction. But the non-registered software has a one limitation: You cannot get a printed copy of the calendar or 
charts that You can see in our great Print Preview. In fact, the non-registered software includes a bonus feature - the nag box.    
This is an added incentive for users to register the software rather than to continue using it too long without paying.

See also
Why should I register ?
How can I register ?



      

Why should I register ?
      

· You liked this software
· You`d like to use this software as long, as You wish
· You`d like to get free technical support
· You`d like to get free upgrades to this software

Finally, by registering the software, You provide us with the resources and incentive to create new features and improvements in this
software, making it the best, support this software and to develop additional quality software products in the future.

See also
How can I register ?



      

How can I register ?
      

For your convenience and protection, we provide the following secure methods of registration:

· Internet (Online)
· Telephone (TOLL-FREE if you are using RegSoft) 
· Fax
· Postal mail

We recommend you to use the online registration - it is the fastest, secure and reliable method. Your encrypted credit card 
information will be sent by using SSL (Secure Socket Layer) transaction.
The registration fee for Femta is US$ 18.    We accept Visa, MasterCard, American Express, Discover(Novus) and cheques or 
money orders (by postal mail).
You can register this software by using Registration Wizard or via the World Wide Web using the Order link on the Femta Web 
homepage.
After processing your payment the registration service company will sent a registration code to you through e-mail. You can enter it 
by using the Registration Wizard.

Note: In case of any problem, please contact us by e-mail sales@femta.com

See also
Registration Wizard
Licensing details



 

Licensing details
    

Femtaâ  Copyrightã 1999 by Oleg Lisovsky.
All rights reserved.

1. Distribution

This software may be freely distributed, provided that:

1.      Such distribution includes only the original archive supplied by authors.    You may not alter, delete or add any files in the 
distribution archive.
2.      The distribution does not includes a registration code.    In particular, you may not distribute a registered version of Femta.

For information about redistribution of Femta e-mail us: info@femta.com 

2. License

By receiving and/or using Femta software, you accept the following Evaluation and Registered User Agreement.    This agreement is
a binding legal agreement between authors of Femta and the purchasers, users or evaluators of Femta.    If you do not intend to 
honor this agreement, remove the installed Femta software from your computer now.

3. Evaluation (Unregistered) and Registered User Agreement

Disclaimer: This software is provided on an "as is" basis, without any other warranties, or conditions, expressed or implied, including
but not limited to warranties of merchantable quality, merchantability or fitness for a particular purpose, or those arising by law, 
statute, usage of trade or course of dealing. The entire risk as to the results and performance of this software is assumed by you. 
Neither we nor our dealers or suppliers will have any liability to you or any other person or entity for any indirect, incidental, special 
or consequential damages whatsoever, including but not limited to loss of revenue or profit, lost or damaged data or other 
commercial or economic loss, even if we have been advised of the possibility of such damages or they are foreseeable; or for claims
by a third party. You may have other rights which vary from state to state. 

You may evaluate the unregistred program for maximum of fifty calendar days, after which you must register the program or remove 
it from your computer.    

You may allow other users to evaluate copies of the unregistered Femta software. All evaluation users are subject to the terms of 
this agreement.

The evaluator/registered user is not allowed to attempt to reverse engineer, disassemble or decompile Femta software and 
products. You may not modify, rent or resell for profit this software, or create derivative works based upon this software.

Any logo or graphics included in Femta software, name and all parts of Femta software are copyright protected.    No program, code,
part, image, algorithm, video clip, audio sample, text or computer generated sequence of images may be copied or used in any way 
by the user except as intended within the bounds of the single user program.

Each registered copy of the Femta may be used by single person who uses this software personally on one or more computers.

If any person other than yourself uses Femta software registered in Your name, regardless of whether it is at the same time or 
different times, then this agreement is being violated !    

The sale or distribution of registered copies of this software is strictly forbidden.    It is a violation of this agreement to loan, rent or 
resell, lease, borrow, or transfer the use of registered copies of Femta.

This license gives you the right to use this software but all rights not specifically mentioned in this agreement, including ownership 
rights, intellectual property rights, trademarks and copyright, are reserved by Oleg Lisovsky.

Warning :
The Femta software includes several protection schemes against hacking, unregistered using this software longer than 50 days, 
changing any part of code or other violations of this User Agreement.
Changed, cracked or patched software, or other violations of this User Agreement cause to incorrect working of this software 
without any warnings or messages.



 

How to record a period
    

You can record a period by 2 ways:

· By using the calendar pop-up menu:
Click the right(second) button of mouse on the starting day of period in the calendar. 
Then click on the Record >>
This menu item contains 4 subitems: 
· Menstruation
· Pregnancy
· Childbirth
· Lactation
Click on the period You want to enter and it will be appeared in the calendar.
Before displaying this pop up menu the automatic checking of possibility to record a period at the chosen date will be done. 
Entries(periods), which are impossible or there is no sense to record at this date, will be grayed. It helps to prevent mistakes.
Tip: If You want to record some period at the selected date, but the needed menu item is grayed - try to do it with the Femta 
Wizard and You`ll get explanations about it.

· By using the Femta Wizard:
· Press the "Wizard" button in the Tool Bar.
· Select "Record >" "period" items from the "Edit" menu in the main menu. The Femta Wizard will be displayed with the 
active "Do it" page.

Note: All the periods will be recorded with the average duration. To know how to change the bound dates of period see the "How to 
change the bound dates of period" topic.

You can undo the most recent command by selecting “Undo” from the Edit menu. Pressing Ctrl+Z has the same effect as selecting 
Undo.

See also
Calendar overview
Wizard overview



      

Getting program updates
      

To check whether you have the most recent version of Femta, please check the Femta home page at http://www.femta.com

Registered user of this version of Femta can use all 1.x versions of Femta without extra charge. 

See also
Getting support
Feedback



      

Getting support
      

Registered users are entitled to technical support, should the need arise.    Please contact us by email at support@femta.com .

When reporting problems, please include the following information:

1) Name of registered user
1) Full description of your problem - provide as much information as possible.    Is the problem reproducible?    If so, how?
2) What version of Windows are you running?    For example, Windows 95, Windows NT 4.0, etc.
3) What version of Femta are you running?    Select About from the Femta Help pull-down menu.
4) If a dialog box with an error message was displayed, please include the full text of the dialog box, including the text in the title 
bar.

Note: You can press F1 any time while Femta is active for context sensitive help.

Before requesting of technical support, please ensure you are using the latest version of Femta available from 
http://www.femta.com/download.htm

See also
Getting program updates
Feedback



      

Feedback
            

If you have any comments or concerns about Femta please direct them to info@femta.com
Your feedback is important to us in order to get an idea of how to make Femta a better product for You.    So if You have a great idea
for a new feature, or a better way of doing something, please send us a note, and we`ll implement it in the future version.

See also
Getting program updates



 

How to change the bound dates of period
    

You can change the starting or ending day of the period by 2 ways:

· By using the calendar pop-up menu:
Click the right(second) button of mouse on the day, which must be the new border of period.
Then click on the Record >> , and choose the same period as the period You want to change. The nearest bound of the period
will be moved to the selected date.
For all periods there are minimum and maximum duration, and dates will not move, if the resulting duration of period out of 
these values.
Tip: If You cannot move the bound of some period to the selected date, try to do it with the Femta Wizard.

· By using the Femta Wizard:
· Press the "Wizard" button in the Tool Bar.
· Select "Note >" "period" items from the "Edit" menu in the main menu. The Femta Wizard will be displayed with the active 
"Do it" page.

Note: You can undo the most recent command by selecting “Undo” from the Edit menu. Pressing Ctrl+Z has the same effect as 
selecting Undo.

See also
Calendar overview
Wizard overview



 

Wizard overview
    

The Femta Wizard can help You to learn how to perform the actions with the periods in Your calendar. It is very easy !
You can access the Femta Wizard by 2 ways :
· Press the "Wizard" button in the Tool Bar.
· Select "Record >" "period" or "Delete" item from the "Edit" menu of main menu. The Femta Wizard will be displayed with the 

active "Do it" page.

Features :

· Easy to use
· Displays explanations of all Your actions 
· Possibility to undo last actions
· Contains only 3 pages :

·        "Select Action" page
·        "Select Period" page
·        "Do it" page

You can use the F1 key any time to get help on a specific screen. 

Using the pop up menu of Femta calendar for operations with notes might be faster and more convenient for You - try it !

See also
"Select Action" page
"Select Period" page
   "Do it" page  
Calendar Overview



 

Print Preview
    

The Print Preview dialog allows You to view how the calendar and charts will be printed on the page. 

With Femta Print Preview You can :

· Select / deselect each object for printing
· Choose the color set for each object
· Change the size of the objects
· Zoom In / Zoom Out page print preview image
· Access the Printer Setup dialog
· Change the alignment and page orientation

You can access the Print Preview dialog by 2 ways :
· Select "Printer Setup..." item from the "File" menu.
· If the "Display Print Preview before printing" option is turned on then pressing on the "Print" button in the Tool Bar will display 

Print Preview dialog.

This page contains the controls, listed below :

Alignment
This list box is used to specify the alignment for placing the objects on the page.

Orientation
In this box You can change the page orientation.

Objects
This list box allows You to select or unselect each object for printing. Clicking by right(second) mouse button on any item, You can 
select / unselect it.    If the item is selected, then the image of checked box appears at the left of this item. All objects corresponding 
selected items will be printed and they are displayed in the print preview image. Using left mouse button You can focus items and 
then change their color sets in the "Color Sets" box.

Color Sets
Using this list box You can choose the color set for the object which is focused in the Object list box. 

Size
This track bar allows You to change the objects on the page. The slider can be moved to the desired position by dragging it with the 
mouse or by clicking the mouse on the bar. 

Buttons

Zoom In, Zoom Out
These buttons allow You to zoom in or zoom out the print preview image. If the image is zoomed in then You can move it by mouse 
with the pressed left button.

Printer...
Displays the Print Setup dialog. It allows change the printer settings(paper size, page orientation etc).

Print
This button is used to print currently viewed objects.

Cancel
Use this button to exit this dialog without printing.

Help
Displays the help about Print Preview dialog.

Note:    The non-registered software has a one limitation: You cannot get a printed copy of the calendar or charts that You can see in
our great Print Preview.

See also
Printer Setup
Program objects overview



 

Calendar preferences
    

The Calendar Preferences dialog allows You to change all colors, fonts and options of calendar. Also this dialog enables You to 
select periods and calculated data for displaying, change its highlighting options.

The Calendar Preferences dialog contains the following objects:

Calendar
It is the same calendar, like the main calendar of Femta. It has 1 row and 2 columns.
The great features :
· It contains Your real periods and data
· It immediately displays the changes of settings
Note: This calendar is located inside the scroll box. If its size by changing of settings becomes larger than size of scroll box, then 
scroll bars will appear.

Data tree view box
It is located at the top right corner of this dialog window.
Data tree view box contains the list of all kinds of data, which can be displayed. Clicking by right(second) mouse button on any item,
You can select / unselect it.    If the item is selected, then the image of checked box appears at the left of this item. Calendar displays
data corresponding selected items only. Using left mouse button You can focus items and change their settings in "Highlighting 
Settings" box.

Colors & Fonts

Top Bar

Starting, Ending
These buttons are used to change the starting and ending colors of the top bar. Top bar is located above the each row of months 
and contains names of months. Selecting the different starting and ending colors gives the color gradient effect. 

Double Blending
When this checkbox is filled in, the double color gradient effect appears: blending of colors from the starting color to the ending, and 
to the starting again. 

Days

Names of days
This button is used to change color of the short names of days.

Days Off
This button is used to change days off color.

Background

Starting, Ending
These buttons are used to change the starting and ending colors of the background.    Selecting the different starting and ending 
colors gives the color gradient effect. 

Double Blending
When this checkbox is filled in, the double color gradient effect appears: blending of colors from the starting color to the ending, and 
to the starting again. 

Fonts

Days
This button is used to change font of days (all dates of calendar, in other words). 
Clicking on the color box near this button allows to change color of days.

Months
This button is used to change the month names font. 
Clicking on the color box near this button allows to change the month names color.

General

Size

Columns, Rows
These controls are used to change the number of rows and columns in the calendar. The greater number of rows and columns, the 



greater number of months, displayed simultaneously. The maximum number of rows and columns is 6.

Start of the week
This list box is used to select name of the first day of the week.

Weekend days
This list allows You to choose the weekend days. Clicking on any name of the day, You can select / deselect it. If the day is selected,
then the image of checked box appears at the left of this name of the day.

Show Tips
If this checkbox is filled in, then tips are turned on. Tip is a short text, displayed whenever the mouse pointer pauses over a date.

Synchronize
If this checkbox is filled in, then synchronization is turned on, and moving on chart will move the calendar to the same date.

Color Sets
This list box is used to select color set of calendar from the list. This list contains several predefined color sets and also can contain 
user-defined color sets.

Highlighting Settings

Highlighting Type
This list box is used to select type of highlighting. There are 5 entries in this list:
· Clear (don`t use background highlighting)
· Rectangle
· Bar
· Arc
· Ellipse

Colors

Starting, Ending
These buttons are used to change the starting and ending colors of the highlighting. The resulting color of highlighting depends on 
calculated probability. The value of probability, equal 0 is corresponding to the starting color, the value equal 1(maximum probability)
is corresponding to the ending color. It is great feature, which gives good visual perception of information.

Font Colors

Starting, Ending
These buttons are used to change the starting and ending colors of the font for highlighted dates. 
See previous info for more details.

Do not use it
When this checkbox is filled in, the highlighting by using font colors is turned off.

Minimum visible probability
Possibility to set the Minimuml visible probability value - is another great feature. It allows You to disable displaying of probabilities 
with low values. You can enter values from 0.00 to 0.99.
Note: Calculated data with probability equal 0 will never be displayed.

Buttons

Save Color Set
Use this button to save custom color set. The "Save color set" dialog will be displayed, then enter a name of color set and click OK.
Note: The current color set has the name "User defined". It saves after pressing OK button.

OK
Pressing on this button saves calendar preferences and closes this dialog window.

Cancel
Use this button to exit this dialog without saving of current preferences.

Help
This button displays the help about Femta calendar.

See also
Displaying data in the calendar
Charts Overview



 

Charts preferences
    

The Charts Preferences dialog allows You to configure all colors, fonts and various options of charts. 

The Charts Preferences dialog contains the following objects:

Chart
It is the same object as You can see in the main window of Femta.
The great features :
· It contains Your data
· It immediately displays the changes of settings
Note: This chart is located inside the scroll box. If its size by changing of settings becomes larger than size of scroll box, then scroll 
bars will appear.

Colors & Fonts

Value Bar

Starting, Ending
These buttons are used to change the starting and ending colors of these bars.    Selecting the different starting and ending colors 
gives the color gradient effect. 

Background

Starting, Ending
These buttons are used to change the starting and ending colors of the background.    Selecting the different starting and ending 
colors gives the color gradient effect. 

Double Blending
When this checkbox is filled in, the double color gradient effect appears: blending of colors from the starting color to the ending, and 
to the starting again. 

Chart

Title
This button allows You to change color of the title.

Axes
This button allows You to change color of the axes.

Days

Color
This button is used to change color of the dates.

Font
This button is used to change font of the dates.

Today

Background
This button is used to change background color of the today date highlighting.

Text
This button is used to change text color of the today date highlighting.

Color Sets
This list box is used to select color set of chart from the list. This list contains several predefined color sets and also can contain 
user-defined color sets.

Chart types
This list box allows You to choose the type of chart. Click on any name of chart to select it. The selected chart and all its preferences
will be displayed.

Properties

Show Tips
If this checkbox is filled in, then tips are turned on. Tip is a short text, displayed whenever the mouse pointer pauses over a date.



Synchronize
If this checkbox is filled in, then synchronization is turned on, and moving on calendar will move the chart to the same date.

Buttons

Save Color Set
Use this button to save custom color set. The "Save color set" dialog will be displayed, then enter a name of color set and click OK.
Note: The current color set has the name "User defined". It saves after pressing OK button.

OK
Pressing on this button saves charts preferences and closes this dialog window.

Cancel
Use this button to exit this dialog without saving of current preferences.

Help
Displays the help about Femta charts.

See also
Displaying data in the charts
Charts Overview
Probability



 

InfoString preferences
    

The InfoString Preferences dialog allows You to configure all colors, fonts and options of the InfoString Bar. 

The InfoString Preferences dialog contains the following objects:

InfoString
It is the same object as You can see in the main window of Femta.
Features :
· It contains Your data
· It immediately displays the changes of settings
Note: This InfoString is located inside the scroll box. If its size by changing of settings becomes larger than size of scroll box, then 
scroll bars will appear.

Colors & Fonts

Text

Color
This button is used to change color of the text.

Font
This button is used to change font of the text.

Background

Color
This button is used to change background color.

Color Sets
This list box is used to select color set of InfoString from the list. This list contains several predefined color sets and also can contain
user-defined color sets.

Buttons

Save Color Set
Use this button to save custom color set. The "Save color set" dialog will be displayed, then enter a name of color set and click OK.
Note: The current color set has the name "User defined". It saves after pressing OK button.

OK
Pressing on this button saves InfoString preferences and closes this dialog window.

Cancel
Use this button to exit this dialog without saving of current preferences.

Help
Displays the help about InfoString.

See also
InfoString Bar Overview
InfoString Pop Up Menu



 

"Common" page
    

This page contains the following controls :

Window
Save window position
If this radio button is selected, then Femta will save the main window position.

Auto set to screen center
Selecting this radio button causes Femta to place its main window to the screen center after starting.

Print
Print immediately
If this radio button is selected, then pressing on the Print button from the Femta tool bar causes to printing of the currently viewed 
charts and calendar without displaying the Print Preview dialog.

Display Print Setup before printing
Selecting this radio button causes to displaying the Print Setup dialog before printing.

Display Print Preview before printing
If this radio button is selected, then pressing on the Print button from the Femta tool bar displays the Print Preview dialog.

Space above the charts
This edit control allows You to change the distance between a chart and the other object.

Display splash screen when application starts
Allows You to enable or disable displaying the Femta splash screen when application starts.

See also
General preferences overview
Print overview
Tool Bar



 

Calendar overview
    

Calendar - is the most important program object of Femta. It has significantly more functions than an usual calendar. The Femta 
calendar allows You conveniently to record periods, view it, displays calculated future periods and data.

Features of the Femta calendar :

· It is eternal calendar with possibility to display dates from 1900 to far future
· View from 1 to 36 months simultaneously 
· Easy browsing
· Focus on the date, pointed by mouse
· Synchronization of moving on dates with the charts
· Conveniently to record, change or delete periods
· Conveniently to view the past periods and calculated future periods and data
· Very configurable :

·        You can select the starting day of week, days off, change their colors, etc.
·        Easy to change the fonts and colors of the calendar
·        Possibility to draw nice gradient background
·      Different types of periods and calculated data highlighting
·        Several predefined color sets
·        Easy to create and save custom color sets

See also
Browsing of calendar
Displaying data in the calendar
Calendar Pop Up Menu
Calendar Preferences



 

Charts overview
    

Charts are very important program objects of Femta. The Femta charts allow You conveniently to view all kinds of calculated data.

Features :

· Easy browsing
· Displays calculated data for all days of a month simultaneously
· Focus on the date, pointed by mouse
· Synchronization of moving on dates with the calendar
· Conveniently to view data as vertical bars, the height of which depend on calculated values
· Very configurable :

·        Easy to change the fonts and colors
·        Possibility to draw nice gradient background
·        Possibility to draw nice gradient value bars
·        Several predefined color sets
·        Easy to create and save custom color sets

There are 5 types of charts in Femta :

· Pregnancy chart
For every woman there are only some days of menstrual cycle, in which she can become pregnant. These days can be 
calculated using data of Your past menstrual cycles. The natural method of contraception is based on calculating of these 
"unsafe" days. With Femta You don`t need to count days, or to do mathematical operations. You only note Your periods, and 
Femta does all the calculations itself.
See the Natural method of contraception, Menstrual cycle topics for more details.
This chart allows You to see the probability to get pregnant (probability of conception, in other words) for every day in the past 
periods and for several months ahead. The greater value for some day, the greater probability to get pregnant this day. 
Note: This applies if You have a intercourse this day and don't use any of the artificial, chemical or hormonal contraceptives.
You can use information from this chart in different ways : 
·  For planning of Your intimate life
·  For contraception
·  If You are trying to become pregnant

· Free Sex chart
If You are using Femta for contraception,    then using of this chart may be the most convenient for You. It displays probability 
not to get pregnant (inverse of previous type of chart).

· Conception (Boy) chart
· Conception (Girl) chart

These charts display the approximate probabilities to conceive a chilld with the gender You wish.
See the Planning a gender of the child topic for more details.

· Childbirth chart
If You are pregnant, this chart helps You to determine the approximate date of childbirth. This chart displays the probabilities of 
childbirth for every day of pregnancy. The greater value for some day, the greater probability of childbirth this day.
Note: Please consult with Your doctor in all the questions about Your pregnancy and childbirth.

See also
Browsing of charts
Displaying data in the charts
Charts Pop Up Menu
Charts Preferences
Probability



 

InfoString Bar
    

InfoString Bar is the Femta program object indicating the current day of cycle (week of pregnancy or lactation).

Features :

· Displays the day (week) number of current period
· Pressing on the InfoString Bar moves the calendar and charts to the today date
· Very configurable :

·        Easy to change the font and colors
·        Several predefined color sets
·        Easy to create and save custom color sets

See also
InfoString Pop Up Menu
InfoString Preferences
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How to upgrade to the new version of Femta
    

You can easy upgrade your Femta to the newest version. 

If You want to install the newest version of Femta :
· Save the Femta database by using the "Save To.." item of the File menu in main menu.
· Uninstall Femta.
· Install the newest version of Femta to the selected folder and run it.
· Load the Femta database by using the "Load From.." item of the File menu in main menu.

If You want to install Femta in the other computer then :
· Save the Femta database by using the "Save To.." command.
· Install Femta in the other computer and run it.
· Load the Femta database by using the "Load From.." command.

Tip: Instead of using the "Save To..." and "Load From..." commands You can save or copy the file Femta.fdb from the Femta folder.
Note: Don`t forget to create the back-up copy of Your Femta database.

See also
File Menu
Installation and Uninstallation



 

Tool Bar
    

The tool bar is composed of short-cuts to frequently used features. You can either use the menu commands or the buttons on the 
tool bar. The tool bar can be in docked or floating mode and located (in docked mode) at the top of main window of Femta(below the
main menu) or at the bottom.

The tool bar contains the following buttons:

Back, Forward
Clicking on these buttons browses the calendar and all charts to a month back or forward.
Clicking at right side of these buttons displays the drop-down menu with following entries : 

Month
Browses calendar and charts a month back(forward)
Calendar
Browses calendar and charts on number of months, contained in calendar
Year
Browses calendar and charts a year back(forward)
Today
Moves calendar and charts to today

Wizard
Displays the Femta Wizard.

Print
This button displays the Print Preview.

View
Displays the drop-down menu that lets to show/hide all the Femta charts.

Help
This button displays the help topics

In its floating mode, a toolbar has a thin title bar and can appear anywhere on your display. A floating toolbar is always on top of all 
other windows. 
In its docked mode, a toolbar is fixed to a dock along any of four borders of the application window. You cannot modify its size when 
it is docked.

To move a toolbar from a dock:
1. Position the mouse pointer in a blank area in the toolbar (not on a button or control).
2. Drag the toolbar away from the dock, and move it to the desired position, either on the desktop or in another dock.

To dock a floating toolbar:
1. Position the mouse pointer over the toolbar title bar or in a blank area in the toolbar.
2. Drag the toolbar to any of the top or bottom window borders of the application window.
3. When the mouse pointer reaches the boundary of the docking area, the toolbar window becomes a single horizontal row of 
buttons.

See also
Program objects overview



 

How to change color of...
    

To change the colors of the Femta calendar, charts or InfoString bar :

· Select appropriate item from the "Preferences" menu in the main menu. The "Preferences" dialog of this object will be 
displayed.

· Click the right(second) button of mouse on this object to call the pop up menu.
Then click on the Preferences item. The "Preferences" dialog of this object will be displayed.

Within "Preferences" dialogs You can change the colors, fonts and other settings. You can create a nice gradient background for the 
calendar or charts.    The "Preferences" dialogs allow You to save the custom color set, or choose the color set from the list. For 
each object there are several predefined color sets. 

See also
Preferences menu
Calendar Preferences
Charts Preferences
InfoString Preferences



 

How to delete a period
    

You can delete a period by 2 ways:

· By using the calendar pop-up menu:
Click the right(second) button of mouse on any day of this period.
Then click on the Delete item. This period will be deleted.

· By using the Femta Wizard:
· Press the "Wizard" button in the Tool Bar.
· Select "Delete" item from the "Edit" menu in the main menu. The Femta Wizard will be displayed with the active "Do it" 
page.

Note: You can undo the most recent command by selecting “Undo” from the Edit menu. Pressing Ctrl+Z has the same effect as 
selecting Undo.

See also
Calendar overview
Wizard overview



 

How to show / hide a period or calculated data on the calendar 
    

You can choose what kind of periods and calculated data to display, type of highlighting them in the calendar, and other options by 
using the Calendar Preferences dialog.

To access this dialog:
· Select the "Calendar Preferences" item from the "Preferences" menu in the main menu. 
· Click the right(second) button of mouse on the calendar to call the pop up menu.

Then click on the Preferences item. 

You can set different starting and ending colors of background (or font). It`s the great feature. The resulting color of highlighting 
depends on calculated probability. The value of probability, equal 0 is corresponding to the starting color, the value equal 1 is 
corresponding to the ending color.
Also You can control the displaying of the calculated data by specifying the Minimum visible probability value. It is another great 
feature of Femta. It allows You to disable displaying of probabilities with low values.

See also
Calendar Preferences
Displaying data in the calendar



 

Keyboard shortcuts
    

You can use the following shortcuts within the main window of Femta:

Key Function

Ctrl+P Print Preview
Ctrl+Q Quit Femta
Ctrl+S Save Femta database to other location
Ctrl+L Load Femta database from other location
Ctrl+Z Undo the last action
Alt+C Display Calendar Preferences form
Alt+T Display Charts Preferences form
Alt+I Display InfoString Preferences form
Alt+G Display General Preferences form
F1 Help
Left, Right Move the calendar and charts a month backward or forward
Home Move the calendar and charts to the today date

See also
Program objects overview



 

Natural method of contraception
    

Great number of women try to avoid using of chemical or hormonal contraceptives. There are a lot of reasons for this: side effects of
such contraceptives, possible negative influence on health now or in future, individual reaction of organism    and many others. For 
some people their religious convictions don't allow to use the contraceptives.

The natural method of contraception is the safest method for health, suitable for almost all women. It has high effectiveness level 
(up to 95%). This method allows to have free sexual life during 18-20 days of cycle (for 28 days cycle).

The natural method of contraception is based on the determining the date of ovulation and calculating the "unsafe" and "safe" 
periods. The "unsafe" period is the days before and following the ovulation, when an egg is released from an ovary and travels 
along a fallopian tube to the uterus. The conception is possible only for these days. This period can be calculated using the date of 
ovulation and the knowledge that the egg survives for 24-48 hours, and the sperm for a maximum of 72 hours. Ovulation occurs 
approximately 14 days before the next menstruation. 
During the "unsafe" period You must avoid the sexual intercourse or use other method of contraception: condoms or coitus 
interruptus. 
Using the information about Your past menstrual cycles is possible to calculate the "unsafe" and "safe" periods.

Femta performs much more complex calculations for You and displays not the simple "safe" days, but the probabilities to become 
pregnant for each day in the past and several months ahead. You can determine possible chances to become pregnant for every 
day and plan Your sexual life.

For women with regular menstrual cycles this method is reliable, but for women with variable in length cycles (which vary in length 
more than 2 days from month to month) it is necessary to use additional methods to determine the date of ovulation more exactly. 
There is the temperature(sympto-termal) method of determining the date of ovulation. (this method will be implemented in the 
next version of Femta). Read the Ovulation topic for more details.

Note:This method is not suitable for a woman, if :
·     Menstrual cycles are very irregular
·     Cycles are shorter than 25 or longer than 35 days
·     Working in the different time(day / night) or with the shift in time (stewardess, for example)

Note: Please consult with Your doctor about contraception.

See also
Ovulation
Menstrual cycle
Charts overview



 

Menstruation
    

The shedding of the lining of the uterus which occurs regularly in women between menarche (the beginning of menstrual periods) 
and menopause (the end of periods). It produces vaginal bleeding which lasts for 3 to 7 days and occurs every 22 - 35 days - the 
length of the menstrual cycle.

See also
Menstrual cycle



 

Ovulation
    

Ovulation is the release of a mature ovum (egg) from the graafian follicle in the ovary. Ovum (egg) is a female reproductive cell. Ova
are formed in the ovaries, pass down the fallopian tubes, and then enter the uterus. Ovulation occurs in the middle of each 
menstrual cycle, approximately 14 days before the start of the next menstrual period. After ovulation the ovum passes along a 
fallopian tube to the uterus.
Ovulation may occur earlier or later by influence of some negative factors: depression, malnutrition, disease.

The conception is possible only during an ovulation. The fertile period lasts for a maximum of 5 days, because sperm can survive in 
the uterus up to 72 hours, and the egg can survive for 24-48 hours. 
Determining the date of ovulation is important for reliable using the natural method of contraception. For women with a regular 
menstruation cycle it is possible to calculate the approximate date of ovulation. But for the other women it is necessary to use 
additional methods to determine the date of ovulation.

There is the well-known and widely practiced temperature(sympto-termal) method. It is used to determine the date of ovulation, 
for contraception, check whether You are pregnant, for diagnostic of menstrual cycles when infertility. This method consists of 
recording the temperature of body for each day of the cycle and observing of the cervical fluid (mucus) and the position of the cervix.
Some women can have special feelings preceding the ovulation.
·   Temperature method will be implemented in the next version of Femta.

See also
Natural method of contraception
Planning a gender of the child
Menstrual cycle
Charts overview



 

Planning a gender of the child
    

Is it possible to conceive a child with the gender you wish ?    Possible answers are Yes and No. There are no methods which 
guarantee the 100% result. But using of some methods can increase the probability to conceive a child with the desired gender. 
The most reliable are the methods based on the scientific information or researches. There is a complex method of artificial 
fertilization including the special processing of sperm. Also there are alternative methods based on a special diet or using age of 
parents and the date of conception.

Femta allows You to try the method, based on the scientific biological information. Its main principle is using different activity and 
duration of life of the spermatozoon with Y-chromosome (which enables the conception of boy) and spermatozoon without this 
chromosome (which enables the conception of girl).
· The closer the sexual intercourse to the ovulation day, the greater probability to conceive a boy.
· Probability to conceive a girl is more if the intercourse occurs 2-3 days before the ovulation.

Note: The alternative methods of planning the gender of a child will be implemented in the next versions of Femta.

See also
Ovulation
Charts overview



 

Pregnancy
    

A normal pregnancy is the period that lasts from conception to delivery. Usually pregnancy lasts 280 days from the first day of the 
last normal period to childbirth.

See also
Menstrual cycle
Lactation



      

Lactation
    

Lactation is the process of secretion of milk from the female breast, which is used to nourish an infant. Lactation begins with the 
birth of the child and is controlled by a complex interaction between various hormones in the mother's bloodstream. The period of 
lactation is the length of time for which nursing of the child continues.

See also
Pregnancy



 

Menstrual cycle
    

The menstrual cycle is the time between the first day of one menstrual period, and the first day of the next one, including the days 
when bleeding occurs. 

The average cycle is 28 days, but some women have a cycle that is consistently longer or shorter than that. The normal menstrual 
cycle is lasting anywhere between 22 and 35 days.
Approximately 14 days before the next menstruation occurs the ovulation.

The absence of periods is usually a sign of pregnancy.

See also
Menstruation
Ovulation
Pregnancy
Natural method of contraception



 

File menu
    

Commands in the File menu let You load or save the Femta database, print calendar and charts, exit Femta. 

Database >>
This menu item contains 2 subitems :

Load From..
This command allows You to load Femta database from selected source. After loading, this database becomes the current. It is 
useful, for example, after installing new version of Femta, or after installing it on a new computer.

Save To..
This command allows You to save Femta database in the selected storage device. It is necessary, for example, for creating the 
back-up copy of Your Femta database, or to de-install this version of Femta and install the newest one.

Printer Setup..
This menu item is used to configure your printer. It displays standard Windows Printer Setup dialog window for changing of printer 
settings(paper size, page orientation etc).

Print Preview..
This command displays Print Prevew dialog. The Print Preview dialog allows You to view how the calendar and charts will be printed
on the page, change settings of Femta objects, change printer settings, and print. 

Exit
This menu item is used to quit Femta.

See also
Print Overview
Printer Setup
Keyboard shortcuts



 

Edit menu
    

Commands in the Edit menu let You note the period, delete notes, undo last action.

Record >>
This menu item contains 4 subitems : Menstruation, Pregnancy, Childbirth, Lactaton.
Selecting any of these entries lets You to record the corresponding period. The Femta Wizard will be displayed.
You can also use the calendar pop-up menu to perform the same operation on the chosen date without displaying of the Femta 
Wizard.

Delete
This command displays the Femta Wizard and allows You to delete chosen periods. You can also use the calendar pop-up menu to 
perform the same operation on the chosen date without displaying of the Femta Wizard.

Undo
Each time you make a change, Femta records the information required to reverse its effect. Select “Undo” from the Edit menu, to 
undo the most recent command. Pressing Ctrl+Z has the same effect as selecting Undo.

See also
Wizard overview
Calendar pop up menu



 

Preferences menu
    

Commands in the Preferences menu let You change preferences of the main objects of Femta.

Calendar...
This menu item displays Calendar Preferences dialog. You can also press Alt+C to perform the same operation.

Charts...
This menu item displays Charts Preferences dialog. You can also press Alt+T to perform the same operation.

InfoString...
This menu item displays InfoString Preferences dialog. You can also press Alt+I to perform the same operation.

General...
This menu item displays General Preferences dialog. You can also press Alt+G to perform the same operation.

See also
Calendar Preferences
Charts Preferences
InfoString Preferences
General Preferences



 

Help menu
    

Commands in the Help menu allow You to see this help, get support or send feedback, visit Femta Home Page, display information 
about Femta.

Contents...
This command displays this help file.    Pressing F1 has the same effect as selecting "Contents..".

Help Topics...
This command displays the help topic list of this help file.

Support...
This command allows You to get the technical support.    It displays the "Send message" dialog of current mail program with filled 
address field. Then describe a problem in the message field and press "Send" button. Also You can send message to 
support@femta.com to get support.
See the Getting support topic for more details.

Feedback...
Use this command to send Your comments or ideas of new features to the authors of Femta.    It displays the "Send message" dialog
of current mail program with filled address field. Sending message to info@femta.com has the same effect.

Femta Home Page...
This command runs the current Internet browser and displays the Femta home page.

Tell Your Friends...
Use this command to support development of this software. Registering and recommending this software to Your friends - the best 
way of doing it.

Copy Link
This command copies the link to the Femta Web home page in the clipboard. You can insert it from clipboard in the message or 
letter.

About Femta...
This command displays "About Femta" dialog, containing information about Femta, version and copyright.

See also
Getting program updates
Getting support
Feedback



 

Register menu
    

This page applies if you are running the evaluation unregistered version of Femta.

Use this command to register Your Femta. This command displays Femta Registration Wizard. You can choose 4 secure methods of
registration : via Internet - Online, by Telephone, or print out a registration form to send it by Fax, or by Mail (cheque or money 
order).

See also
Registration Wizard
What is registration ?
Why should I register ?
How can I register ?
Licensing details



 

"Select action" page
    

This page contains the "Actions" list box to select an action You want to perform.

There are the following items in this list box :

· Enter new period
· Change dates of period
· Enter and change periods
· Delete a period

Select an action, then click the "Next" button. If You've selected the first three items, then the "Select Period" page will appear. If 
You've selected "Delete a period" item, then the "Do it" page will appear. 

See also
   "Select Period" page  
 "Do it" page



 

"Select period" page
    

This page contains the "Period" list box to select a period You want to enter or change.

There are the following items in this list box :

· Menstruation
· Pregnancy
· Childbirth
· Lactation

Select a period, then click the "Next" button and    the "Do it" page will appear.
You can click the "Previous" button to return to the "Select Action" page.

See the Displaying data in the calendar, Charts Overview topics for more information about periods.

See also
   "Select Action" page  
 "Do it" page



 

"Do It" page
        

This page contains the following objects :

Calendar
It is the same calendar, like the main calendar of Femta. It has 1 row and 2 columns.
This calendar contains Your real periods and data.

You want to :
This combo box is used to change the action You want to do without returning to the "Select Action" page. 

Period :
This combo box is used to change the period You want to note or change without returning to the "Select Period" page.

Message box
This message box displays comments and explanations of all Your actions.

Undo button
Click this button to undo the most recent command.

Click the "Finish" button to close the Femta Wizard.
You can click the "Previous" button to return to the previous page.

See also
Calendar Overview
Wizard Overview
   "Select Action" page  
   "Select Period" page  
   "Do it" page  



 

"Calculations" page
    

Use this page to configure some settings for calculations.

Don't use for calculations the cycles with duration
Less, than ... days
More, than ... days
Sometimes the length of menstrual cycle is longer or shorter than average length of the past cycles. It may occur under influence of 
some factors.    If it is occurred, then results of future calculations will depend on the length of this cycle too. You can exclude such 
cycles from calculations by using of these settings. 

Calculate probabilities for future ... months
This edit control allows You to set the number of months from the last period for which the data will be calculated.

See also
General preferences overview
Menstrual cycle



 

"Security" page
    

If You want to prevent viewing Your data in Femta by other people, then You can set the password.
When using of the password is turned on, the Enter Password dialog will be displayed every time Femta is starting. If the incorrect 
password is entered, then Femta will be closed.

This page contains the following controls :

Use password for Femta running
Use this check box to turn on/off using the password for Femta running. If this checkbox is checked, then the password must be 
entered and reentered into the corresponding fields.

Enter password
This field is used to enter the password. The symbols of password are hidden.

Reenter
This field is used to re-type the password for confirmation (to avoid typographical errors). 

Note: Be sure to remember the password You use. 

See also
General preferences overview
Using of password



 

"User Info" page
    

The "User Info" page is used to show information about user.
This page contains the following controls :

Information
Name
This field is used to display the name of registered user.

Date of birth
This field is used to display the user's birthday. Using of this date will be implemented in the next versions of Femta.

See also
General preferences overview
What is registration ?
How can I register ?



 

General preferences overview
    

The General Preferences dialog allows You to configure main window preferences, calculation settings, set the password, and see 
information about user.
You can access the General Preference dialog by 2 ways :
1. Select "Preferences" from the main menu. Then select "General..." from the "Preferences" pull-down menu.
2. Press Alt+G.

The preferences in this dialog are grouped under four tabs (pages) :

· "Common" page
This page is used to change the main window settings and print preferences.

· "Calculations" page
This page is used to change the settings for calculations.

· "Security" page
Use this page if You want to enter the password for starting of Femta, turn on/off using it.

· "User Info" page
This page displays information about user.

You access a page by clicking on its tab. 
You can use the F1 key any time to get help on a specific screen. 
Press the OK button to save changes, or Cancel to cancel the changes and close this dialog.

See also
"Common" page
"Calculations" page
   "Security" page  
   "User Info" page  
Main Menu Overview



 

Status Bar
    

A status bar occupies the bottom of Femta window and displays text.
· Status bar displays the "Tip" messages, whenever the mouse pointer pauses over the calendar or charts, even if "Show Tips" 

option is turned off
· Status bar displays the short information, describing the function of Main menu item or Tool Bar button, whenever the mouse 

pointer pauses over them.

You can hide/show the status bar by using the Status Bar entry in the View pull-down menu.

See also
Program objects overview



 

Printer Setup
    

The Printer Setup dialog is used to specify printer settings.
You can access this dialog by 3 ways :
· Select "Printer Setup..." item from the "File" menu.
· Press the "Printer..." button within the Print Preview dialog.
· If the "Display Print Setup before printing" option is turned on then pressing on the "Print" button in the Tool Bar will display 

Printer Setup dialog.

Within this dialog you may select the printer you want to use, the orientation and paper size. For information about which settings to 
use, refer to the documentation which comes with your printer.

If you have more than one printer connected to your computer or network, click on the arrow in the list box beside the “Name” field 
to select a printer from the list.

Many printers have specific settings (such as page orientation, paper size and graphics resolution) which you can specify to get the 
printing results you want. Click on the “Properties” button to see specific options available for the selected printer.

See also
Print overview
Print Preview



 

Print overview
    

With Femta You can easy print the calendar and charts, see the WYSIWYG print preview in order to look at the objects on the page 
before you print it out, choose color sets for printing of objects, change printer settings.

You can start printing by 3 ways :
· Click on the "Print" button of the tool bar. See below for more details. 
· Select "Print Preview..." item from the "File" menu of main menu. 
· Press Ctrl+P.    The Print Preview dialog will be displayed.

If You click on the "Print" button of the tool bar then there are 3 variants of execution :

Display Print Preview before printing
The Print Preview dialog will be displayed. Then user can change settings and print or close this dialog.

Display Print Setup before printing
The Print Setup dialog will be displayed. It allows to change the printer settings(paper size, page orientation etc).Then currently 
viewed objects will be printed.

Print immediately
Currently viewed objects will be printed without displaying of any dialogs.

You can choose one of them from the "Common" page of the General Preferences dialog.

Note:    The non-registered software has a one limitation: You cannot get a printed copy of the calendar or charts that You can see in
our great Print Preview.

See also
Print Setup
Print Preview
Main Menu overview
Tool Bar
General preferences overview



 

Program objects overview
    

The main window of Femta contains the following objects :

· Main Menu
· Tool Bar
· InfoString Bar
· Calendar
· Up to 5 charts
· Status Bar

Each of these objects(excluding Main Menu) can be visible or invisible.
For more detailed information about these objects read the corresponding topics.

See also
Main Menu Overview
Tool Bar
InfoString Bar
Calendar Overview
Charts Overview
Status Bar



 

Calendar pop up menu
    

Commands in the Calendar pop up menu let You record or delete a period,    browse the calendar, change some options, display 
Calendar Preferences dialog and display this help about the calendar. 

If You are clicking on a date, then this date appears on the top of pop up menu.

Record >>
This menu item contains 4 subitems: 
· Menstruation
· Pregnancy
· Childbirth
· Lactation
This allows You to record a period started from the selected date.
This command also can be used to change the starting or ending day of some period. If You`ve chosen from this pop up menu some
period, and the selected date belongs to the same period, the closest bound of period will be moved to this date.
Features :
· Before displaying this pop up menu the automatic checking of possibility to record a period at chosen date will be done. 

Entries(periods), which are impossible or there are no sense to record at this date, will be grayed. It helps to prevent mistakes.
· For all periods there are minimum and maximum duration, and dates will not moved, if the resulting duration of period out of 

these values.
Note: Childbirth - is the particular "period". Its duration is 1 day, and this day is the last day of pregnancy.
Tip: If You want to record some period at the selected date, but the needed menu item is grayed - try to do it with the Femta Wizard 
and You`ll get explanations about it.
 
Delete
This command allows You to delete a period. If there are no period at this day, this menu item will be grayed.

Back >>,    Forward >>
This menu items contain 3 subitems each: 
· Month
· Calendar
· Year
These menu items are used to browse the calendar to month, calendar, year    back or forward accordingly.

Today
This command moves the calendar to the today date. 

Show Tips
This command turns on or off the tips. Tip - it is the short text, displayed whenever the mouse pointer pauses over a date.

Synchronize
This command turns on or off synchronization. If synchronization is turned on, then moving on chart will moves the calendar to the 
same date.

Preferences...
Displays Calendar Preferences dialog.

Help
This command displays the help about Femta calendar.

See also
Browsing of Calendar
Calendar Preferences



 

Browsing of Calendar
    

You can browse the Femta calendar by several different ways :

· By pressing the buttons, located at the left and right sides of calendar. One click moves the calendar to one month back or 
forward. If You still hold this button, then calendar will browse repeatedly until You release the button.

· By using calendar pop up menu. It contains Back and Forward entries. These entries have a sub-menu each with the following
items: Month, Calendar, Year. Select these items to browse the calendar accordingly. The calendar pop up menu also 
contains the Today entry. Select it to move calendar to today.

· By using tool bar browse buttons. Read the Tool Bar topic for more details.

· If the Synchronize mode of calendar is enabled, moving on the chart will moves the calendar to the same date as the date on 
which You are moving in the chart.

See also
Tool Bar
Calendar Overview
Calendar Pop Up Menu
Calendar Preferences



 

Displaying data in the calendar
    

The very useful and necessary feature of the Femta calendar is possibility to display the periods and calculated data. You can 
choose what kind of periods and calculated data to display, type of highlighting them in the calendar, and other options.
    
You can see the following data in the calendar:

The past or current periods :
· Menstruation
· Pregnancy
· Childbirth
· Lactation

Note: Childbirth - is the particular "period". Its duration is 1 day, and this day is the last day of pregnancy.

Calculated data(probabilities):
· Menstruation - the probability of menstruation
· Pregnancy - the probability to get pregnant (probability of conception, in other words)
· Free Sex - the probability not to get pregnant (inverse of previous kind of data)
· Conception (Boy) -    the probability to conceive a boy
· Conception (Girl) -    the probability to conceive a girl
· Childbirth - the probability of childbirth

Also the today date can be highlighted like other data.
See the Charts Overview topic for information about some kinds of calculated data.

For all kinds of data You can set (see the Calendar Preferences topic for more details) :
· Type of background highlighting:

· Clear (don`t use background highlighting)
· Rectangle
· Bar
· Arc
· Ellipse

· The starting and ending colors of background highlighting
· The starting and ending colors of font
· Minimum visible probability

Possibility to set different starting and ending colors of background (or font) - it`s the great feature - the resulting color of highlighting
depends on calculated probability. The value of probability, equal 0 is corresponding to the starting color, the value equal 1 is 
corresponding to the ending color.
Possibility to set the Minimum visible probability value - is another great feature. It allows You to disable displaying of probabilities 
with low values.

Note: Calculated data with probability equal 0 never will be displayed.

See also
Calendar Preferences
Charts Overview



 

Browsing of charts
    

You can browse of the Femta chart by several different ways :

· By pressing the buttons, located at the left and right sides of the chart. One click moves the chart to one month back or 
forward. If You still hold this button, then chart will browse repeatedly until You release the button.

· By using chart pop up menu. It contains Back and Forward entries. These entries have sub-menu with the following items: 
Month, Year. Select these items to browse the chart accordingly. The chart pop up menu also contains the Today entry. Select
it to move chart to today.

· By using tool bar browse buttons. Read the Tool Bar topic for more details.

· If the Synchronize mode of chart is turned on, moving on the calendar will moves the chart to the same date as the date on 
which You are moving in the calendar.

See also
Tool Bar
Charts Overview
Charts Pop Up Menu
Charts Preferences



 

Displaying data in the charts
    

The chart contains 2 axes : horizontal and vertical.
On the horizontal axis the dates of month are placed. The bottom of vertical axis is corresponding to the minimum value of 
probability (0). The top of vertical axis is corresponding to the maximum value of probability. The maximum value - is maximum 
related to the others days (it is not the mathematical maximum probability that is equal 1 and trustworthy for 100%).
The data are displayed on the chart as vertical bars. The greater height of some bar, the greater the calculated value of probability 
for this day.
You can set a nice gradient background for values bars for better visual perception of information.

See also
Charts Overview
Charts Preferences
Probability
 



 

Charts pop up menu
    

Commands in the Charts pop up menu let You browse the calendar, change some options, display Charts Preferences dialog and 
display this help about charts. 

Today
This command moves the chart to the today date. 

Back >>,    Forward >>
These menu items contain 2 subitems each: 
· Month
· Year
These menu items are used to browse the chart to month, year    back or forward accordingly.

Show Tips
Turns on or off the tips. Tip is a short text, displayed whenever the mouse pointer pauses over a chart.

Synchronize
Turns on or off synchronization. If synchronization is turned on, then moving on calendar will moves the chart to the same date.

Hide
This command hides this chart.

Preferences...
Displays Charts Preferences dialog.

Help
This command displays the help about Femta charts.

See also
Browsing of Charts
Charts Preferences



 

InfoString pop up menu
    

Commands in the InfoString pop up menu let You move the calendar and charts to today, display InfoString Preferences dialog and 
display this help. 

Today
Moves the calendar and the charts to the today date. 

Hide
This command hides InfoString Bar.

Preferences...
This command displays InfoString Preferences dialog.

Help
Displays the help about InfoString Bar.

See also
InfoString Bar Overview
InfoString Preferences



 

Main Menu overview
 

The Main Menu contains the following entries:

· File
· Edit
· View
· Preferences
· Help
· Register (applied if you are running the evaluation unregistered version of Femta)

Clicking on the every entry displays a pull-down menu with commands.
Also You can display these menus by pressing Alt+underlined symbol (Alt+V for View menu, for example).
For more detailed information about these menus read the corresponding topics.

See also
File menu
Edit menu
View menu
Preferences menu
Help menu
Register menu



 

How to undo the last action
    

Every time You make a change, Femta records the information required to reverse its effect. Select “Undo” from the Edit menu, to 
undo the most recent command. Pressing Ctrl+Z has the same effect as selecting Undo.

See also
Main Menu overview



 

View menu
    

Items in the View menu let You show or hide the program objects of Femta.

Calendar
Pregnancy Chart
Free Sex Chart
Conception (Boy) Chart
Conception (Girl) Chart
Childbirth Chart
Tool Bar
InfoString Bar
Status Bar

Each of these items can be checked or unchecked. By clicking on the item it switches to the inverse state. If the item is checked, 
then corresponding object is visible. You can show or hide an object by clicking on selected item. 
Also You can hide charts and InfoString Bar by using pop up menus.

See also
Program objects overview



 

Probability
    

The probability is an objective characteristic of events that does not depend on our attitude towards them. If a casual event occurs 
as consequence from one of M events with the total number of N possible events then probability of this event is ratio M / N . 

The probability of any event is between 0 and 1. The probability of the impossible event is 0, and for trustworthy event is 1.

In ordinary life, probability is understood to mean something like a rough assessment of chance.

In Femta probability is the relative value. The value of 1 means the most possible event from other events, and does not mean that 
this event will be occurred with 100% trustworthy.



 
WYSIWYG - What You See Is That You Get



      

System Requirements
    

Femta - is 32 bit application. It requires Windows 95, 98 or Windows NT 3.51 or higher.
When installed it occupies about 1 Mb of the disk space.    

We recommend You to use the display resolution at least 800x600 and hi-color(16 bit) or true color (24 or 32 bit) video mode.

See also
Installation and Uninstallation



 

Registration Wizard
    

This page applies if you are running the evaluation unregistered version of Femta.

The Registration Wizard allows You to perform registration easy. 

At first it let You choose one of our registration service companies. Currently our distributors are 2 companies: RegSoft, United 
States and Soft-Shop, United Kingdom.
Then You can get information about the methods of registration: Internet - Online, Telephone, Fax, Postal Mail. 

After that the Registration Wizard will started your Internet browser to open the Femta order page from the chosen registration 
service company Web-site. This Page contains instructions about each methods of payment.

After processing of your payment the registration service company will sent a registration code to You by e-mail. To complete the 
registration start the Registration Wizard again and enter your name and registration code in the corresponding fields.

·  If You've registered Femta without using this Wizard then to enter your registration code start this Wizard and click on the 
Femta registration logo image, which placed at the top left corner of the first page. The page which allow to enter your code will
be opened.

Note: The registration code contains from 30 to 40 case-sensitive symbols. It`s better to copy the registration code from the letter 
You received by using Windows clipboard to avoid errors of manual typing.

Note: In case of any problem, please contact us by e-mail sales@femta.com

See also
What is registration ?
Why should I register ?
How can I register ?
Licensing details



 

Using of password
    

If You want to prevent viewing Your data in Femta by other people, then You can set the password.

When using of the password is turned on, the Enter Password dialog will be displayed every time Femta is starting. If the incorrect 
password is entered, then Femta will be closed.

Note:      Be sure to remember the password You use. If You forget your password then:
· If You are not the registered user of Femta then You should install this application again.
· If You are registered user then You can enter the first 5 symbols of Your registration code.

See also
General preferences overview




